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What Makes People do Research?  

This is a fundamentally important question. No person would like to do research 

unless there are some motivating factors. Some of the motivations are the 

following: 

(1) to get a research degree BSc, MSc or  Ph.D. along with its benefits like better 

employment, promotion, increment in salary, etc. 

(2) to get a research degree and then to get a teaching position in a college or 

university or become a scientist in a research institution 

 (3) to solve the unsolved and challenging problems 

(4) to get joy of doing some creative work 

(5) to acquire respectability. 

(6) to get recognition 

(7) Curiosity to find out the unknown facts of an event 

(8) Curiosity to find new things 

(9) to serve the society by solving social problems. 

Some students undertake research without any aim possibly because of not being 

able to think of anything else to do. Such students can also become good 

researchers by motivating themselves toward a respectable goal.  
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What is a thesis? 

A thesis or dissertation is a document submitted in support of candidature for 

an academic degree or professional qualification presenting the author's research. 

Structure of a dissertation 

1- Title page 

2- Acknowledgements 

3- Abstract (Summary) 

4- Table of Contents 

5- List of Tables 

6- List of Figures 

7- List of Appendices 

8- Chapter 1 - Introduction 

9- Chapter 2 -  Literature review 

10- Chapter 3- What you thought and made 

11- Chapter 4 – Experiments and Analysis 

12- Chapter 5- Conclusion and future work  

13- References 

14- Appendices 

15- Abstract in Kurdish and Arabic languages 

Structure of research article 

1- Author and author's professional affiliation is identified 

2- Abstract 

3- Introduction 

4- Literature review section (a discussion about what other scholars have 

written on the topic) 

5- Methodology section (methods of data gathering are explained) 

https://en.wikipedia.org/wiki/Academic_degree
https://www.scribbr.com/category/dissertation/#structure-of-a-dissertation
https://www.scribbr.com/category/dissertation/#title
https://www.scribbr.com/category/dissertation/#acknowledgements
https://www.scribbr.com/category/dissertation/#abstract
https://www.scribbr.com/category/dissertation/#table-of-contents
https://www.scribbr.com/category/dissertation/#list-of-figure-tables
https://www.ldeo.columbia.edu/~martins/sen_sem/thesis_org.html#Figures
https://www.scribbr.com/category/dissertation/#lift-of-abbreviations
https://www.scribbr.com/category/dissertation/#introduction
https://www.scribbr.com/category/dissertation/#theoretical-framework
https://www.scribbr.com/category/dissertation/#conclusion-discussion
https://www.scribbr.com/category/dissertation/#references
https://www.scribbr.com/category/dissertation/#appendices
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6- Results 

7- Discussion section 

8- Conclusions 

9- Reference list with citations (sources of information used in the article) 

 

1- Title page 

The title page is the front page and therefore the eye catcher of your dissertation.  

i. The title should be neither too long nor too short; 

ii. It should be focused and interesting; 

iii. It should include the keywords you might use to describe your work; 

iv. Try to use some verbs rather than a long list of nouns. 

Information page 

Information about your supervisors, information about yourself (name, student 

administration number and email address) and information about your educational 

program. Finally, end this page with the date on which the dissertation is 

submitted. 

2- Acknowledgements 

Acknowledgements should be include: 

 Supervisor’s assistance 

 Faculty staff ( University, College and Department); 

 All those who have helped you with ideas, technical assistance, materials; 

 Family and friends. 

 

3- Abstract 

The abstract is an important component of your thesis. Presented at the 

beginning of the thesis, it is likely the first substantive description of your work 

read by an external examiner. You should view it as an opportunity to set 

accurate expectations. 

     That means The abstract is a summary of the whole thesis. It presents all    

https://www.scribbr.com/dissertation/dissertation-title-page/
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     the major elements of your work in a highly condensed form. 

 

It should state 

 The problem in a general manner; 

 The problem in a specific manner; 

 The main objectives of the work; 

 The main methods or tools used; 

 The main results and conclusions. 

How not write an abstract  

 Do not refer extensively to other works; 

 Do not add information not contained in the original work; 

 Do not define terms. 

Answers to these questions should be found in the abstract:  

o What did you do?  

o Why did you do it? What question were you trying to answer?  

o How did you do it? State methods. 

o What did you learn? State major results.  

o Why does it matter? Point out at least one significant implication. 

Size and Structure 

 Currently, the maximum sizes for abstracts submitted to Canada's National 

Archive are 150 words (Masters thesis) and 350 words (Doctoral 

dissertation). 

 

4- Table of Contents 

                                                                         Page  

         List of Figures                                          xxx 

         List of Tables      

         Chapter One  

              Subheads 

         Chapter Two  
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         Chapter Three 

         Conclusion 

         Recommendations 

         References 

        Appendices 

        Abstract in Arabic                                  a 

       Abstract in Kurdish 

 

5- List of Figures 

List page numbers of all figures. 

The list should include a short title for each figure but not the whole caption.   

 

6- List of Tables 

List page numbers of all tables. 

The list should include a short title for each table but not the whole caption.   

 

 

7- Introduction 

  The introduction chapter of your thesis is to one which you provide all of the 

basic information that the reader will need to understand the report which is to 

follow. Such things as the background of your research,  

 How you came to research your topic, 

 What your topic is and how it relates to the world around it, and  

 What kind of general principles and methodology you will be using to 

research your topic and evaluate your hypothesis. 

Tell the reader the aims and objectives of the study. Give the reader a sense of 

how the thesis will be organized. Provide some kind of chapter by chapter 

breakdown to tell the reader what can be expected so that the reader will able to 

scan the report at first and have a good sense of what ended up happening. 

 

Note:  An introduction must not be so detailed that it includes everything you 

want to say. Remember that you are introducing an idea or topic, your structure of 

the essay, and your thesis statement. 

 

8- Literature Review  
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    A literature review surveys books, scholarly articles, and any other sources 

relevant to a particular issue, area of research, or theory, and by so doing, 

provides a description, summary, and critical evaluation of these works in 

relation to the research problem being investigated. Literature reviews are 

designed to provide an overview of sources you have explored while 

researching a particular topic and to demonstrate to your readers how your 

research fits within a larger field of study. 

 

   Within each section of a literature review, it is important to discuss how the     

 research relates to other studies (how is it similar or different, what other     

 studies have been done) as well as to demonstrate how it relates to your own  

 work. 

    The literature you identify must be read, summarized, discussed and analyzed, 

not just listed. 

Literature refers to a collection of published information/materials on a particular 

area of research or topic, such as books and journal articles of academic value. 

What are the three main purposes of literature? 

An author's purpose is the main reason he or she has for writing. The three basic 

purposes are to inform, to persuade, and to entertain. 

 

9- Questions a Literature Review should answer 

*    Are there any gaps in the research? Are there areas that haven’t been looked   

    at closely yet, but which should be? Are there new ways of looking at the topic? 

* Are there improved methodologies for researching this subject? 

* What future directions should research in this subject take? 

* How will your research build on or depart from current and previous research   

   on the topic? What contribution will your research make to the field?   

 

 

 Source of the literature review 

* Journals. The most important source 

* Books –classic in the field 
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* Conferences-often from the supervisor(s) 

* Standards, laws, etc. 

 

10- Methods 

What belongs in the “methods” section of a scientific paper? 

1- Information to allow the reader to assess the believability of your results. 

2- Description of your materials, procedure, theory., equipment 

3- Calculation, technique, procedure, equipment and calibration plots. 

4- Limitations, assumptions and range of validity. 

 

The methods section should answer the following questions: 

5- Could another researcher accurately find and reoccupy the sampling stations 

or track lines? 

6- Is there enough information provided about any instruments used so that a 

functionally equivalent instrument could be used to repeat the experiment? 

7- If the data is in the public domain, could another researcher lay his or her 

hands on the identical data set? 

8- Could one replicate any statistical analyses? 

9- Could another researcher approximately replicate the key algorithms of any 

computer software? 

 

Note: Do not include descriptions of result. 

 

11- Results 

1- The results are actual statements of observations, including statistics, tables 

and graphs. 

2- Mention negative results as well as positive. 

3- Present sufficient details so that others can draw their own inferences and 

construct their own explanations. 

 

Note: do not interpret results-save that for the discussion. 

 

12- Conclusions 

 This should summarize your results and discussion. You should include a list 

of the most important findings of your study in descending order of importance. 
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Conclusions should also be linked with the objectives of the study. You should 

also provide a statement about the possibility of future study. What needs to be 

done and what does study contribute? 

 

13- What is referencing? 

 Referencing is a system that allows you to acknowledge the contributions of 

others in your writing. Whenever you use any words, ideas or information from 

any source your assignments, you must reference those sources.  This means 

that if you use the exact words of an author, if you paraphrase their words or if 

you summarize their ideas, you must provide a reference. Not referencing your 

sources means you may be charged with plagiarism and your work could be 

failed. 

1. How to Create a blank document 

 
1- Open Word. Or, if Word is already open, select File > New. 

2- Select Blank document. 

 

 

3- Double-click a template to open it. 

 

2. Click to layout, Margins then custom Margins 
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3. Choice the font type  
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4. 4.For Writing an Argumentative Thesis  

1- Choice your main subject. 

2- Research about your subject in the books or in the internet. 

3- define the keyword of subjects.  

General Considerations  

White papers A4 (297 X 210 mm) are used, and printing should be on one 

side of the paper. 

The margins should be as follows: 3 cm for the left margin and 2 cm for 

other margins. 

Page Layout ----  Page Setup -----Margins----- Custom Margins----page setup—

Margins 
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The font type is “Times New Roman”. 

    Home----Font 

 

                                    

The font size should be as follows:  14 for the text; 12 for table;     

  20 for titles of the body of the text parts ; 18 for headings and 16 for subheadings. 

Line spacing should be 1.5 space of the Microsoft Word computer program 

throughout the text.  3 line spacing between the main title and the text. 

Single spacing may be used only in the Table of Contents, charts, graphs, 

tables,  appendices, and bibliography.  

   Home ---Paragraph     
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  Bold: Main title, heading and subheading 

Home---Font 

                          

Right (or left)  justification statements. 

Home----- Paragraph 

                       

Numbering of Pages  

Preliminary pages should be paginated with lower case  

    Roman numerals(e.g., i, ii, iii) starting with title page. However, the number on 
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the title page should not be shown, although the page is counted as i. 

Ordinarily, page numbers should be centered at the top or bottom of the page. 

Pagination in Arabic numerals starts with the first page of introduction 

through the appendices pages. 

Insert------- Header &Footer-----page number-----format page numbers 

             

Note:  

To change the style of numbering pages for example, from Roman to 

Arabic: 

Page layout----Breaks--- next page---- insert----page number----format page 

numbers. 

New paragraph preferably starts at column 1 of the Microsoft word computer 

program, leaving 3 line spacing between the paragraphs.  

     However, new paragraph may start at column 3 of the Microsoft word computer 

program without leaving extra space between paragraphs. 

The number of pages is not more than 120 pages or 20000 words for MSc 

thesis 
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Titles of the body of text should be written in upper case letters,  

     For example,  INTRODUCTION, LITERATURE REVIEW. 

    Home----Aa 

                                   

The title of the sub-section should have the first letter in upper case.  

Each sub-section of a chapter should be given a numerical index, e.g. the 

first section of chapter 1 is written as 1.1.   

Further  subsection / subheading of the above is written as 1.1.1.  

 The numerical index for the next section will be 1.2. and for further 

subsection as 1.2.1.  

Using multi-level numbering for document headings  

  To number all headings throughout the document, including within tables of 

contents:  

 Highlight the first title or heading within your document.  

  From the Home tab go to the Styles section and click on   
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     one of the Heading options to apply it to the highlighted    

     text.  

                      

 On the Home tab, click on Multilevel List in the Paragraph    

    group to display the List Library. 

                                        

Choose a layout that includes the Heading style names 

                                        

Creating a table of figures  

If you have pictures, diagrams or tables in your document, it is useful to list  

them in a table of figures. To create a caption: 

 Click on the image or table . 

 A References tab       Insert Caption       Captions  

            group to display the Caption dialog box.  
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 At Label, select the appropriate label for the object.  

You can choose from Equation, Figure or Table, or you can create your own 

through New Label.  

                              

                                           

                           

 

References 

Referencing is a system that allows you to acknowledge the contributions of others 

in your writing 

 

 
REFERENCING SYSTEM 
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1- Harvard Referencing  

2- MLA Referencing  

3- APA Referencing  

4- Oxford Referencing  

5- OSCOLA Referencing  

6- Vancouver Referencing Style  

7- Turabian Referencing  

8- Chicago Referencing  

9- BMJ Referencing  

10- Open University Referencing 

The following details information are taking for each book, journal article, or 

electronic source.   

For books, record: 

 The author’s or editor’s name (or names);  

 The year the book was published;  

 The title of the book;  

 If it is an edition other than the first;  

 The city the book was published in;  

 The name of the publisher.  

For journal articles record:  

 The author’s name or names;  

 The year in which the journal was published;  

 The title of the article;  

 The title of the journal;  

 The page number/s of the article in the journal;  

For electronic resources, record: 

 The date you accessed the source;  

 The electronic address or email;  

 The type of electronic resource (email, WWW page, etc).  

http://www.essaycoursework.com/modelanswer/referencing/harvard-referencing.php
http://www.essaycoursework.com/modelanswer/referencing/mla-referencing.php
http://www.essaycoursework.com/modelanswer/referencing/apa-referencing-style.php
http://www.essaycoursework.com/modelanswer/referencing/oxford-referencing-style.php
http://www.essaycoursework.com/modelanswer/referencing/oscola-referencing-style.php
http://www.essaycoursework.com/modelanswer/referencing/vancouver-referencing-style.php
http://www.essaycoursework.com/modelanswer/referencing/turabian-referencing.php
http://www.essaycoursework.com/modelanswer/referencing/turabian-referencing.php
http://www.essaycoursework.com/modelanswer/referencing/chicago-referencing.php
http://www.essaycoursework.com/modelanswer/referencing/bmj-referencing.php
http://www.essaycoursework.com/modelanswer/referencing/open-university-referencing.php
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Create a Bibliography using  Microsoft — Word 

Step 1: 

Open your document in Microsoft Word and click on the Referencestab.  

                                      

 

Step 2: 

Place your cursor where you would like the citation inserted. Select your style of 

references in the Style menu, shown in the screen shot below.  

                                 

Step 3: 

In Click on the Insert Citation button to produce 

 the drop-down menu shown below, and select Add New Source.  

                                   

Step 4: 
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A Create Source window will appear.  

Choose the source type from the drop-down menu.  

                                     

Step 5: 

Enter the source information in the fields provided and click OK.  

                                   

Step 6: 

In the screen shot below, note that a reference has been entered. Follow Steps 2–5 

to insert your remaining references.  

                                      

Step 7: 

Once you have entered all references and sources, place your cursor at the end of 

your document. Click on the Bibliography button, shown below, and select 

eitherBibliography or Works Cited.  
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Step 8: 

To update the bibliography after entering new sources, click anywhere on the 

bibliography table. Click on Update Citations and Bibliography 

                                    

 

 

 

Vancouver  

 Uses numeric references in the text;  

 either numbers in brackets (1) or superscript (1); 

 The reference list lists publications in the order they appeared in the text, not 

alphabetically.  
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BOOKS 

 Author(s) 

 Title (capitalize only the first letter of the first word and any proper nouns) 

 Edition (only include the edition number if it is  not the first edition) 

 Place of publication: publisher; Year of publication  

Example  

Dym CL, Little P, Orwin EJ, Spjut RE. Engineering design. 3rd ed. Hoboken: 

Wiley; 2009.  

Electronic books (ebooks) 

 Author(s) 

 Title of book[internet] 

 Publication details [cited…] 

 Available from: URL 

Wear A. Knowledge and practice in English medicine [internet]. Cambridge: 

Cambridge University Press; 2000 [cited 2015 June 17]. Available from: 

http://site.ebrary.com/lib/bham/detail.action?docID=5004608 

JOURNALS 

 Author(s) 

 Title of article 

 Title of journal (capitalise all initial letters) 

 Date of publication as year month day 

 Volume (issue):Page numbers (not preceded by p.) 

 

Knapik JJ, Cosio LM, Reynolds KL. Efficacy of functional movement.  Strength 

Coned Res. 2015; 29 (5): 1157-1162.  

E-Journal 

 Author(s) 

 Title of article 

http://site.ebrary.com/lib/bham/detail.action?docID=5004608


22 
 

 Title of journal (capitalise all initial letters) [internet] 

 Date of publication as year month day [cited year month day]; 

 Volume (issue):Page numbers (not preceded by p.) 

 Available from: URL  

Knapik JJ, Cosio-Lima LM, Reynolds KL. Efficacy of functional movement. 

Strength Cond Res [internet]. 2015 [cited 2015 June 23]; 29(5): 1157-1162. 

Available from: http://journals.lww.com/jscr/Abstrac 

Papers from conference proceedings 

 published on the internet 

 Author(s) 

 Title of paper (in single quotation marks) 

 Title of conference(location and date of conference) [cited…] 

 Publisher 

 Available from: URL 

 

Jones D. ‘Developing big business’, Large firms policy and research conference 

(University of Birmingham, 1999 Dec 18-19) [cited 2014 Jan 19]. Leeds: 

Institute for Large Businesses; 1999. Available from: 

http://www.bigbusinesses.co.uk/jonesd 

 

How to paraphrase sources 

Paraphrasing means formulating someone else’s ideas in your own words. To 

paraphrase a source, you have to rewrite a passage without changing the meaning 

of the original text. 

Paraphrasing is an alternative to quoting, where you copy someone’s exact words 

and put them in quotation marks. In academic writing, it’s usually better to 

paraphrase instead of quoting, because it shows that you have understood the 

source and makes your work more original. 

Every time you paraphrase, it’s important to cite the source. You also have to be 

http://journals.lww.com/jscr/Abstrac
http://www.bigbusinesses.co.uk/jonesd
https://www.scribbr.com/citing-sources/how-to-quote/
https://www.scribbr.com/language-rules/quotation-marks/
https://www.scribbr.com/category/citing-sources/
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careful not to use wording that is too similar to the original. Otherwise, you could 

be at risk of committing plagiarism. 

How to paraphrase in five steps 

Paraphrasing tips 

How to cite a paraphrase 

Paraphrasing vs. quoting 

Paraphrasing vs. summarizing 

Avoiding plagiarism 

How to paraphrase in five steps 

1. Read the passage several times to fully understand the meaning 

2. Note down key concepts 

3. Write your version of the text without looking at the original 

4. Compare your paraphrased text with the original passage and make minor 

adjustments to phrases that remain too similar 

5. Cite the source where you found the idea 

What is your plagiarism score? 

Compare your paper with over 60 billion web pages and 30 million publications. 

* In partnership with Turnitin 

* Best plagiarism checker of 2019 

* Plagiarism report & percentage 

* Largest plagiarism database. 

• What makes a good poster? 

1- Important information should be readable from about 10 feet away 

2- Title is short and draws interest 

https://www.scribbr.com/category/plagiarism/
https://www.scribbr.com/citing-sources/how-to-paraphrase/
https://www.scribbr.com/citing-sources/how-to-paraphrase/
https://www.scribbr.com/citing-sources/how-to-paraphrase/
https://www.scribbr.com/citing-sources/how-to-paraphrase/
https://www.scribbr.com/citing-sources/how-to-paraphrase/
https://www.scribbr.com/citing-sources/how-to-paraphrase/
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3- Word count of about 300 to 800 words 

4- Text is clear and to the point 

5-  Use of bullets, numbering, and headlines make it easy to read 

6- Effective use of graphics, color and fonts 

7- Consistent and clean layout 

8- Includes acknowledgments, your name and institutional affiliation 
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